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[bookmark: _Toc232606123]ABSTRACT[footnoteRef:3] [3:  Major heading for prefatory chapters in style “NDSU 0”.] 

Disquisition templates are designed and maintained by the NDSU Center for Writers for your convenience. They may require modification to fit the style manual of your discipline. More information about using our templates can be found in our template manual and style cheat sheet. Additionally, our website is your one-stop resource for more information about:
the Graduate School Publication Review process, including semester deadlines for submission, where you can find help with writing and formatting your disquisition, how to incorporate the style manual of your discipline into this template, and our policies on copyright and co-authored material;
our full guidelines for formatting, construction, and accessibility, including guides on converting your document to PDF and creating landscape-oriented pages;
your pre-submission requirements and a pre-submission checklist.
If you need assistance with formatting, please make an appointment with a graduate consultant at the Center for Writers or Instructional Design Center. If you encounter issues while using our templates, would like to request a feature, or have questions about the Publication Review, please contact the Disquisition Coordinator.
The Abstract page is required in your document and should be page “iii” of the disquisition. Abstracts for doctoral dissertations may be up to 350 words. Abstracts for master’s papers or master’s theses may be up to 150 words. When your disquisition is published, this abstract will be included alongside its entry, making it available on Google Scholar, Web of Science, ProQuest, NDLTD, and the NDSU Institutional Repository. For dissertations and theses, this abstract should match the abstract in your ETD on ProQuest.
[bookmark: _Toc232606124]ACKNOWLEDGMENTS
This page is optional; delete it if you do not use it. Acknowledgments text should be placed here. In this section, you can acknowledge or thank those who assisted or supported you in your disquisition, and you can acknowledge any external funders that may have supported your project with grant funding. Use the “NDSU Paragraph Double Space 0.5 First Line” style for the paragraph text.
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This page is optional; delete it if you do not use it. This section dedicates the disquisition to one or more persons, groups, or causes as tribute to their support or influence. The text should be double spaced and aligned center to the page with no paragraph indentation.
TABLE OF CONTENTS[footnoteRef:4] [4:  Major heading for the Table of Contents in style “NDSU X”. This style is used to set the Table of Contents and the title of your disquisition as heading level 1 for the purpose of tagging and bookmarks, but these two headings should not appear in the Table of Contents.] 

ABSTRACT	iii
ACKNOWLEDGMENTS	iv
DEDICATION	v
LIST OF TABLES	viii
LIST OF FIGURES	ix
LIST OF _______	x
LIST OF ABBREVIATIONS	xi
LIST OF SYMBOLS	xii
LIST OF APPENDIX TABLES	xiii
LIST OF APPENDIX FIGURES	xiv
AN INTRODUCTION TO OUR TEMPLATE AND ITS STYLES	1
A Word on Styles	1
A Word on Non-text Items	3
A Word on Images	4
A Word on Equations	7
CONVERTING YOUR DOCUMENT TO PDF	9
REFERENCES	10
APPENDIX A. APPENDIX FORMATTING AND ITS SPECIAL RULES	11
APPENDIX B. TIPS FOR FORMATTING AND ACCESSIBILITY	12
Text from Other Documents or the Web	12
Spacing Content	12
APPENDIX C. FORMATTING CODE IN THE CHAPTERS AND APPENDICES	13
APPENDIX D. RESOURCES AND INFORMATION FOR DISQUISITION WRITERS	15
[bookmark: _Toc232606126]LIST OF TABLES
Table	Page
1.	Title of table in “NDSU Table Title” style, which should use the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the prefatory list and update it to pull the title into the list. After updating a prefatory list, remove bold from any text, remove the “table” and “figure” label from in front of each number, then apply the “NDSU List Entry: Tables/Figures/Etc” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title.	3
2.	A sample regular table whose title uses the “NDSU Table Title” style.	6

[bookmark: _Hlk201922169]NOTE TO USER: To populate a prefatory list with titles or update a list after making changes to item titles, right-click the list, select “Update Field”, then choose to update the entire list. Updating an entire list will reset its formatting; remove any bold text, remove the item label (e.g., “table” or “figure”) from in front of each entry, then apply the “NDSU List Entry: Tables/Figures/Etc.” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title. Page numbers for entries in prefatory lists can be updated without resetting formatting; update all prefatory lists, including the Table of Contents, before you convert your document to a PDF. Delete this note before you submit your disquisition.
[bookmark: _Toc232606127]LIST OF FIGURES
Figure	Page
1.	Bison statue #1. It was donated to NDSU by Jim and Sandra Roers, with contributions from Ronald G. and Kaye S. Olson and Student Government. It is dedicated to the memory of Dr. Les Pavek, Vice President of Student Affairs, and Michael William Barner. The statue once stood inside a bank in Minnesota. Alt-text describing this image has been added.	5
2.	Title of the figure. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated in figure 1.	6

[bookmark: _Toc232606128]NOTE TO USER: To populate a prefatory list with titles or update a list after making changes to item titles, right-click the list, select “Update Field”, then choose to update the entire list. Updating an entire list will reset its formatting; remove any bold text, remove the item label (e.g., “table” or “figure”) from in front of each entry, then apply the “NDSU List Entry: Tables/Figures/Etc.” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title. Page numbers for entries in prefatory lists can be updated without resetting formatting; update all prefatory lists, including the Table of Contents, before you convert your document to a PDF. Delete this note before you submit your disquisition.
LIST OF _______
Item 	Page
1. 	If you use schemes or any other type of non-text item, include a prefatory list for these items (e.g., “List of Musical Examples”) in your prefatory material. “NDSU Other Item” and accompanying styles are included in this template by default.	6

NOTE TO USER: If you have non-text items other than tables or figures in your disquisition, you may need to label them and list them in a prefatory directory like this one. Examples include musical examples, schematics, code examples, algorithms, equations… You can relabel the title and column header of this page to suit your needs and populate it with the item titles formatted with the style “NDSU Other Item title”. Delete this note before you submit your disquisition.
[bookmark: _Toc232606129]LIST OF ABBREVIATIONS
Abbreviation	Explanation of the Abbreviation. Remove these entries before submitting your disquisition. This section is optional.
[bookmark: _Hlk201922296]Directions	This page has been formatted with an automatic dot leader and our required alignment. Press “Enter” after the previous definition to start a new entry. After typing the abbreviation, press “Tab” once to get the Dot Leader up to the definition column. There is also a Style for these list entries: “List Entry Abbreviations, Symbols”. Remove these entries before submitting your disquisition.
ETD	Electronic Thesis or Dissertation
[bookmark: _Toc232606130]LIST OF SYMBOLS
[bookmark: _Hlk201920707]Symbol	Explanation of Symbol. If the symbol text runs longer than one line, the subsequent lines are aligned with the first word in the entry. Remove this entry before submitting your disquisition. This section is optional.
Directions	After entering the Symbol, press Tab to get an automatic dot leader to the definition column. After typing the definition, press Enter to start a new line for a new symbol. Remove this entry before submitting your disquisition.
™	Trademark
[bookmark: _Toc232606131]LIST OF APPENDIX TABLES
Table	Page
A1.	Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).	11
 
NOTE TO USER: To populate a prefatory list with titles or update a list after making changes to item titles, right-click the list, select “Update Field”, then choose to update the entire list. Updating an entire list will reset its formatting; remove any bold text, remove the item label (e.g., “table” or “figure”) from in front of each entry, then apply the “NDSU List Entry: Tables/Figures/Etc.” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title. Page numbers for entries in prefatory lists can be updated without resetting formatting; update all prefatory lists, including the Table of Contents, before you convert your document to a PDF. Delete this note before you submit your disquisition.

[bookmark: _Toc232606132]LIST OF APPENDIX FIGURES
Figure	Page
A1. 	Bison created in a beta version of Adobe Firefly, a generative AI app. We do not recommend using AI-generated content in your disquisition. Like all other content, scholarly accountability should guide the use of AI tools, and AI-generated work should be cited.	11

NOTE TO USER: To populate a prefatory list with titles or update a list after making changes to item titles, right-click the list, select “Update Field”, then choose to update the entire list. Updating an entire list will reset its formatting; remove any bold text, remove the item label (e.g., “table” or “figure”) from in front of each entry, then apply the “NDSU List Entry: Tables/Figures/Etc.” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title. Page numbers for entries in prefatory lists can be updated without resetting formatting; update all prefatory lists, including the Table of Contents, before you convert your document to a PDF. Delete this note before you submit your disquisition.
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[bookmark: _Hlk201922362][bookmark: _Toc232606133]AN INTRODUCTION TO OUR TEMPLATE AND ITS STYLES[footnoteRef:5],[footnoteRef:6] [5:  If co-authored materials are included in your disquisition, a clear and complete description of your contribution should be included. No co-authored materials can be included in the disquisition if your contribution is modest, even though you may have been included as a co-author. Place the description of your role in a footnote, indicated at the chapter heading in which the co-authored material appears. You can find an example of this footnote on our website.]  [6:  Major heading for chapters in style “NDSU 0”.] 

[bookmark: _Hlk201922387]These templates are developed, maintained, and supported by the NDSU Center for Writers. While these templates are generally constructed in accordance with the NDSU Publication Guidelines, they are not an authoritative source for formatting and accessibility and you may find discrepancies between our requirements and the formatting shown here; for example, URLs in your disquisition should be black with no underlining, whereas this guideline is not followed in the template to avoid useability issues. Similarly, headings are organized to showcase different styles rather than organized in a logical reading order. See our disquisition knowledge base for our full guidelines on formatting and accessibility, including tips and troubleshooting for common issues, such as how to convert your document to PDF with bookmarks. If you plan to graduate in Spring 2027 or later, note that our requirements for digital accessibility are changing beginning Jan 1, 2027.
We frequently update our templates to address emerging issues and ensure their ease of use. If you have acquired your template from your department, advisor, or colleague, we recommend instead downloading a new template from our website.
[bookmark: _Toc232606134]A Word on Styles[footnoteRef:7] [7:  First-level subheadings in style “NDSU 1”.] 

Use our “NDSU” styles to simplify your formatting; we do not recommend using the default styles included with Word. The NDSU styles in our templates have been created for your convenience, and it is your responsibility to use them appropriately to create a document that complies with the NDSU Publication Guidelines. If you would prefer to use different styling, such as a different font or to change the line spacing before and after non-text items, you are welcome to change these styles in any way that conforms to our guidelines. 
Styles for headings, paragraph text, non-text items, and many other elements are available by default, but you may need to modify them to fit the style manual of your discipline or for your specific use. For paragraph text, use the style “NDSU Paragraph Double Space 0.5 First Line”. 
For bulleted list items, use the “NDSU Bulleted/Numbered List” style from the styles pane. Bulleted and numbered lists should be formatted consistently throughout the document, including their alignment and style. For example, if one numbered list uses parentheses to punctuate its item numbers, all numbered lists should.
[bookmark: _Hlk211431288][bookmark: _Hlk201929464]Styles are used in some automatic features included with this template, such as to populate the Table of Contents and prefatory lists (e.g., Lists of Tables/Figures/etc) and create bookmarks in your converted PDF. Heading styles are numbered according to their outline level: major headings are “NDSU 0”, first-level subheadings are “NDSU 1”, etc. Styles for non-text items are marked as “table”, “figure”, etc. Create or modify our default styles as necessary; for example, if you include figure notes below figure titles for only some of your figures, it may be useful to have separate styles for figures with notes and figures without notes since their line spacing options will be different. 
Refer to our disquisition knowledge base, our user guide “How to Use NDSU Disquisition Templates” and our Word Crash Course videos for more information about formatting with styles, modifying styles to fit your style manual’s guidance, and using and adjusting this template.
[bookmark: _Hlk201922598]Excepting the Title and Disquisition Approval pages, all content in your disquisition—in both the prefatory pages and disquisition body—should have an “NDSU” style applied to it. 
[bookmark: _Toc232606135]A Word on Non-text Items
[bookmark: _Hlk201922610]The styles for non-text items in our templates have been set for their most common use and may require manual adjustment—review the line spacing options for your non-text items on a case-by-case basis. Non-text items, such as tables, figures, schemes, etc., should be formatted consistently, and they should not extend into the 1” page margins; enable gridlines in the View tab to help identify items that extend into page margins. An item’s titles and notes should be on the same page as the item itself. For large tables or figures that cannot fit onto a single page, see our knowledge base entry on non-text items for formatting instructions.
Your non-text items may look different from the examples in our templates (Table 1); we encourage you to follow the style of your discipline. A consistent design is required for all tables, including borders, font, and the line spacing separating them from their surrounding content.
[bookmark: _Toc232606221][bookmark: _Hlk201926830]Table 1. Title of table in “NDSU Table Title” style, which should use the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the prefatory list and update it to pull the title into the list. After updating a prefatory list, remove bold from any text, remove the “table” and “figure” label from in front of each number, then apply the “NDSU List Entry: Tables/Figures/Etc” style to the entries. Entries will not appear correct immediately—you will need to insert a tab space (Tab key) in front of each item title.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	Data
	Data

	Row 2
	Data
	Data
	Data


[bookmark: _Hlk201926783]Note: The “NDSU Table Note” style is used to format table notes, including line spacing. Table notes are single spaced and have the same font typeface and size as the paragraph text. If you do not have a table note, use the “NDSU Table No Notes” style on the line after the table instead. 
We recommend using only regular tables without any merged cells[footnoteRef:8]. For each table, designate whether a table has a header row, header column, or both in the Table Design tab; for example, Table 1 has only the “header row” option checked, indicating that the first row is a header row and that the first column is not a header column. See our knowledge base entry on non-text items for our full guidelines, including examples of irregular tables. [8:  Irregular tables are those that contain merged cells, which are commonly used to create nested headers and sub-tables. If your document contains one or more irregular tables, you will need to manually assign header IDs and set the table scope for each cell in each table during the remediation phase of your review. Conversely, documents with regular tables can be automatically scoped by your reviewer. See this video tutorial for more information about setting header IDs and scope in tables. ] 

[bookmark: _Toc232606136]A Word on Images[footnoteRef:9] [9:  Second-level subheadings in style “NDSU 2”.] 

[bookmark: _Hlk201922756]Figures and other images should be formatted consistently, including the use of borders and the line spacing separating them from their surrounding content. Figures and other images may have a full border or no border. Images should be cropped to remove any extraneous whitespace; you can use the crop tool within Word or an image editing program, such as MS Paint or GIMP. If an image includes text, the text may be no smaller than Times New Roman size 8 and should have a color contrast ratio greater than 3:1. See our knowledge base entry on non-text items for our full guidelines, including examples and settings on line spacing as well as instructions for setting alt-text.
In an accessible PDF, images should be tagged as figures, and the tag should have alt-text describing the image. In Word, alt-text can be added to images from their Picture Format tab. See our knowledge base entry on alt-text for our full guidelines, including examples. Images in your PDF should also have a bounding box that defines their location on their page, defined in the tag’s properties; Word 365 will automatically create bounding boxes for images, whereas PDFs created from Office LTSC will require additional remediation.
[bookmark: _Hlk201927103]A Word on Formatting Figures[footnoteRef:10] [10:  Third-level subheading in style “NDSU 3”.] 

[bookmark: _Hlk201922859]Set images to be in-line with text and use the appropriate style to format them, such as the “NDSU Figure” style. Figures and other non-text items should be formatted according to your discipline’s style guide—it may differ from our examples (Figure 1). While we recommend minimizing the amount of dead whitespace in your document where possible, blank space due to the layout of non-text items—such as the whitespace at the end of page 3—is generally acceptable. However, do not use line breaks or carriage returns to space out content; see Appendix B for more information.
[image: A photograph of Bison Statue #1. The bison statue sits in front of South Engineering, across from the Library and Minard Hall. ]
[bookmark: _Toc232519472][bookmark: _Hlk201923017]Figure 1. Bison statue #1. It was donated to NDSU by Jim and Sandra Roers, with contributions from Ronald G. and Kaye S. Olson and Student Government. It is dedicated to the memory of Dr. Les Pavek, Vice President of Student Affairs, and Michael William Barner. The statue once stood inside a bank in Minnesota. Alt-text describing this image has been added.
Note: If you reproduce content from copyrighted sources, such as published material, you should cite the original source of the item and obtain any necessary permissions to reproduce it. Refer to the style manual of your discipline and the copyright section of our policies for more information. Use the “NDSU Figure Note” style for notes related to your figures.
[bookmark: _Toc148017014][bookmark: _Toc232606222]Table 2. A sample regular table whose title uses the “NDSU Table Title” style.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	
	30
	31

	Row 2
	
	32
	N/D


Note: This table has both a header row and header column set in its options. Set these options as appropriate for your tables under the Table Design tab. This note uses the “NDSU Table Note” style.
A Word on Other Types of Non-text Items
Items schematics, musical examples, and other non-text items should be labeled and titled and included in an appropriate prefatory list (Musical Example 1). 
[image: An excerpt of a duet written for a flute and clarinet in 6/8 time. The flute plays a lively melody with eighth- and sixteenth notes while the clarinet plays a slower, sustained accompaniment using quarter notes and longer tones. ]
[bookmark: _Toc232606298]Musical Example 1. If you use schemes or any other type of non-text item, include a prefatory list for these items (e.g., “List of Musical Examples”) in your prefatory material. “NDSU Other Item” and accompanying styles are included in this template by default.
Note: Use the “NDSU Other Item Note” style for notes on these types of items. If you have multiple types of “other items”, you may need to create styles for each type.
[image: A Bison logo from NDSU Athletics.]
[bookmark: _Toc232519473][bookmark: _Hlk201924769]Figure 2. Title of the figure. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated in figure 1.
A Word on Listings[footnoteRef:11] [11:  Fourth-level subheading in style “NDSU 4”.] 

We recommend hosting your code on a public repository and including a link in your disquisition. If you include code in your document, use the “NDSU Listing/Code” styles (Listing 1). See Appendix C and our knowledge base entry on listings for more information.
Listing 1. Use “NDSU Listing/Code” style to format code blocks. If you wish to maintain indentation from pasted code, you may have to manually use CTRL+TAB to indent items.
function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
	t1 = t2 - ts;
	a=1; %scales normal distribution to 1
	b=.5*60/bpm; % centers the mean at 1/2 of the cycle
	c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
	k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
	dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-	b)/(2*c.^2)) + (Emax-	Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-	2*(t1-b)/(2*c.^2));
End
Note: Notes for listings/code blocks should use the “NDSU Listing/Code Note” style and should employ the same line spacing scheme before and after them as other non-text items. Like other non-text items, a listing shouldn’t be broken across pages if it can fit onto a single page.
[bookmark: _Toc232606137]A Word on Equations
[bookmark: _Hlk201924462]Display equations should be centered on their own line, to help them stand out from the paragraph text. Equation numbers are optional; if you number your display equations, they should either be numbered consecutively throughout the document (1, 2, 3, etc.) or consecutively within each chapter (1.1, 1.2, 2.1, 2.2, etc.). Equation numbers should be flush against the right margin. Use the “NDSU Equation” style to automatically set the tab stops below, then tab the equation and its number manually. This style sets two tab stops: a 3.25” centered tab is used for the equation and a 6.5” right tab is used for its number.
		(1)
		(2)
[bookmark: _Toc147744729]Display equations and inline equations should use the same font as the paragraph text; the XITS font is used for equations in our templates to match Times New Roman. Note that while Word equations may be toggled between “display” or “inline”, numbered equations are incompatible with equations set to “display”.
In an accessible PDF, display and inline equations should be tagged as formulas and have alt-text. If you convert your document to PDF using our specific instructions, Word 365 will automatically tag equations and generate alt-text for them. However, Word LTSC will not, and equations created in Word LTSC then exported from Word 365 may have both tagging and rendering issues. You can determine the version of Word you’re using under File -> Account. 
More information on equations can be found in our knowledge base entry on equations, including our full guidelines as well as tips for formatting them and special considerations for making them accessible. For more information on using this template, see our help document How to Use NDSU Disquisition Templates.
[bookmark: _Toc232606138]CONVERTING YOUR DOCUMENT TO PDF[footnoteRef:12] [12:  If you reproduce copyrighted content in your disquisition, you are responsible for the appropriate use and attribution of that content, including obtaining any necessary permissions or licenses. For more information on copyright, including how to obtain permission to reproduce copyrighted content, see the copyright section of our policies page.] 

[bookmark: _Toc147744725][bookmark: _Hlk201924277]After you’ve defended your disquisition and completed any final revisions from your committee, you will need to convert your document to PDF before beginning the publication review process.
Converting your Word document to PDF is not a 1:1 process, meaning that you should review your document both before and after you export it to ensure it remains compliant with our publication guidelines. For example, one common issue when converting to PDF are broken page numbers in the prefatory lists; while this problem is easily identified by reviewing your converted PDF—and easily fixed by re-styling the offending content—submitting a document with broken page numbers will necessitate an additional review, which may delay your graduation.
In Word, you can view formatting marks with the “Show/hide formatting marks” button (¶) on the Home tab in the Paragraph section (Ctrl+Shift+8). Some formatting is embedded in styles for your convenience; for example, the major heading style automatically forces the heading to appear at the top of a new page. Do not use line breaks (Enter) to space out content, as any changes that cause upstream content to shift will cause issues for content below these line breaks. Instead, if you need to force content onto a new page—such as for a full page table or figure—use the “page break before” option under the content’s paragraph settings. See Appendix B for more formatting tips.
[bookmark: _Toc232606139]REFERENCES[footnoteRef:13] [13:  Major heading for a reference section in style “NDSU 0”. If you use reference sections within chapters, they should be sub-sections within that chapter.] 

[bookmark: _Hlk201924858]Citation example using the “NDSU Citation” style. This style is double spaced with a hanging indent, but you are welcome to use a format that fits your disciplinary conventions. 
[bookmark: _Hlk201924843]Follow your discipline’s style guide for reference list formatting guidance and modify our style as necessary. If you elect to include reference sections for each chapter, these sections should be included as sub-sections within the chapter. See our knowledge base entry on reference sections for our full guidelines.
[bookmark: _Hlk201924850]Use only one citation style. For example, do not mix APA and AMA citation styles in your document.
[bookmark: _Hlk201924805]Before submitting your document, proofread all entries. Citations that have been automatically generated by citation management software likely have missing information or inconsistent formatting. Double-check all citations for accuracy and completeness, paying special attention to capitalization, punctuation, author names, font style, consistency in how you list journal titles (e.g., full vs. abbreviated, italicized), and compliance with the citation style manual you are using.
Citation citation citation citation citation citation citation citation citation citation citation citation citation citation.
[bookmark: _Toc232606140]APPENDIX A. APPENDIX FORMATTING AND ITS SPECIAL RULES 
[bookmark: _Toc147744732][bookmark: _Hlk201924905]If you include appendices in your document, they should generally be formatted similarly to the content in your chapters, but special rules and exceptions can apply to your appendix material; see our knowledge base entry on appendix material for our full guidelines and Appendix D for an example of one special rule. 
If you have only one appendix, remove the letter A from the major heading, but keep using the letter A in any item numbers to denote that they are appendix tables or figures (Table A1). Item numbers in the appendix should be numbered similarly to those in the chapters; for example, if items are numbered by chapter (e.g., “1.1”, “1.2”, “2.1”) then appendix items should use the same format (e.g., “A.1”, “A.2”, “B.1”).
[bookmark: _Toc148016770][bookmark: _Toc201927547][bookmark: _Toc232519593]Table A1. Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	
	

	Row 2
	
	
	



[image: AI slop of a bison.]
[bookmark: _Toc148016202][bookmark: _Toc232606650]Figure A1. Bison created in a beta version of Adobe Firefly, a generative AI app. We do not recommend using AI-generated content in your disquisition. Like all other content, scholarly accountability should guide the use of AI tools, and AI-generated work should be cited.
[bookmark: _Toc232606141]APPENDIX B. TIPS FOR FORMATTING AND ACCESSIBILITY[footnoteRef:14] [14:  Major appendix heading in style “NDSU 0”.] 

[bookmark: _Toc232606142]Text from Other Documents or the Web[footnoteRef:15] [15:  First-level appendix subheading in style “NDSU 1”.] 

Text copied from outside sources, such as websites or PDFs, frequently contains hidden formatting that will interfere with the formatting of your document and, in some cases, delay its publication. When you copy text from another source, you should strip its formatting before copying into your disquisition: use Paste Special – Unformatted Text option from the paste menu to remove formatting, then apply the appropriate style from the Styles Pane. 
[bookmark: _Toc232606143]Spacing Content[footnoteRef:16] [16:  Second-level appendix subheading in style “NDSU 2”.] 

We do not recommend using page breaks, line breaks, and carriage returns to add additional spacing before, after, or between your content because they frequently cause formatting and accessibility issues.
If you have content that should appear at the top of a new page, use the “page break before” option under paragraph settings. This option is useful when trying to place large tables or figures and is enabled by default for major heading styles. Manual breaks create issues when content shifts, causing the break to “spill over” and create a blank page, whereas this setting pins the content to the top of a page. This setting is enabled by default for our major heading styles.
Similarly, content can be anchored together with the “keep with next” and “keep lines together” settings. This option is useful for keeping non-text items together with their titles and notes. Our non-text item styles use these settings by default, but you may need to manually adjust them; for example, if some figures have notes whereas others do not, those figures with notes should have “keep with next” enabled for their titles, anchoring the title to the note.
[bookmark: _Toc232606144]APPENDIX C. FORMATTING CODE IN THE CHAPTERS AND APPENDICES 
We recommend hosting your code on a public repository, such as GitHub, and linking to the repository from your disquisition. If you want to include snippets, pseudocode, scripts, or code in general within your disquisition, use the “NDSU Listing/Code” style to format code blocks with line numbers and border frames; use the accompanying “NDSU Listing/Code” styles for titles and any notes. See our knowledge base entry on listings for our full guidelines, including troubleshooting for line numbers and borders. If you have listings within your disquisition, we recommend including a List of Listings in the prefatory pages; see our knowledge base entry on section order for more information on this list’s placement.
Listing C1. Code should be formatted using “NDSU Listing/Code” style. This style applies a number to each line. If necessary, you can use CTRL+TAB to indent items on a line.
1: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
2: t1 = t2 - ts;
3: a=1; %scales normal distribution to 1
4: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
5: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
6: 
7: %makes the spread of curve to 50% duty cycle
8: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
9: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-	Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
10: End
11: 
12: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
13: 
14: t1 = t2 - ts;
15: a=1; %scales normal distribution to 1
16: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
17: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
18: 
19: %makes the spread of curve to 50% duty cycle
20: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
21: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
22: End
23: 
24: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
25: 
26: t1 = t2 - ts;
27: a=1; %scales normal distribution to 1
28: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
29: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
30: 
31: %makes the spread of curve to 50% duty cycle
32: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
33: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
34: End
35: 
36: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
37: t1 = t2 - ts;
Notes for listings/code blocks should use the “NDSU Listing/Code Note” style and should employ the same line spacing scheme before and after them as other non-text items. Like other non-text items, a listing shouldn’t be broken across pages if it can fit onto a single page.
[bookmark: _Toc232606145]APPENDIX D. RESOURCES AND INFORMATION FOR DISQUISITION WRITERS
	NDSU Website
	For more information about:

	Graduate School Current Students
	Graduate School policy, deadlines, forms, graduation.

	· https://www.ndsu.edu/graduate-school/academic-support

	Graduate School Dissertations, Theses, and Papers
	Disquisition policies, formatting and accessibility guidelines, new templates, guides to using the templates, submission procedures, publication and delayed release information.

	· https://www.ndsu.edu/cfwriters/disquisitions

	Center for Writers (CFW)
	Writing and formatting consultations and workshops, technical assistance for Word and LaTeX templates, disquisition boot camps, and writing resources.

	· www.ndsu.edu/cfwriters/

	Instructional Design Center (IDC)
	Thesis formatting workshops, technical and formatting assistance for Word. Note: The IDC offers technical help with Word but does not consult on guidelines nor conduct reviews of your formatting.

	· https://www.ndsu.edu/it/help/idc

	Formatting Tutorial Videos
	Hosted on the GPS Academy YouTube Channel. “Navigating the Review Process” workshop recording and “Word Crash Course” videos on In-Paragraph Formatting; Styles; Section Breaks and Page Numbers; Table of Contents; Tables and Figures; Landscape Pages and More about Tables; Template Overview.

	· https://youtube.com/playlist?list=PLWKsN3lW50IexOpLRkNjh2HDuVKp3XjFH&si=Cksb4ZlFK3X1uCCh


Note: Non-text items like tables or figures that appear alone in an appendix do not require titles and should not have entries in a List of Appendix Tables/Figures. See our knowledge base entry on appendix material for more information.
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